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1  Introduction
1.1  Determination of space requirements and budget with SIMARIS
project
With SIMARIS project you can get an overview  of the space requirements for the electric pow er distribution w ithin a building, from medium voltage

to distribution boards, and thus get the basis for a cost estimation.

Having defined the project structure and selected the basic technical data, the required

n panels for medium voltage 
n transformers

n protective and sw itching devices for low  voltage 

n busbar trunking systems, including the specif ication of special components such as feed-in components, directional change components and

pow er tap-off units

n charging units for electric vehicles

n and other single components

can be selected.

By automatically selecting and placing suitable pow er distribution board systems based on your specif ications, SIMARIS project f inds the space

requirements of the pow er distribution as w ell as the basic data for determining the required budget, w hich you can request from your Siemens

contact w ith the data from SIMARIS project. Or, you can draft it yourself in a budget sheet that can be saved. From Version 2.0 on, the program

also contains the automatic creation of technical specif ications.

1.2  System requirements
These are the minimum hardw are and softw are requirements to run SIMARIS® project:

n Processor: Intel Core i3 / AMD Phenom II X4 
n 4 GB RAM

n Free hard disk space: 2.3 GB (if  a country is selected) up to 10 GB (if  all countries are selected)

n Screen resolution

- Format 4:3: 1280x1024 (recommended 1400x1050)

- Format 16:9: 1366x768 (recommended 1680x1050)

n Supported operating systems: Window  s 7, Window  s 8

n Supported MS-Office versions: Off ice 2007, Off ice 2010
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1.3  Setup instructions
1.3.1  Setup from DVD
n Close all other applications on your computer. 
n Insert the SIMARIS DVD into the DVD drive and start setup.exe.

n The setup w izard guides you through the installation and not only enables you to install SIMARIS project, but also SIMARIS design and SIMARIS

curves. SIMARIS project cannot be selected for all countries ow ing to the product portfolio contained, so that this program can only be installed

if you have selected at least one of the available countries in the country selection. A specif ication of countries for w hich SIMARIS project is

currently available can be found at w w w .siemens.com/simarisproject 

n Follow  the instructions of the setup w izard. 

n SIMARIS project can be set up as local installation only, i.e. not as a netw ork installation.

n Please check after program installation, w hether updates are available and install them if required. To check w hether an update is available,

you can use the Help menu  à "Start online-update" to make a query provided your computer is connected to the Internet. Then you can

directly install available updates online. Another option is to use the Help menu  à "Dow nload update package" to call the corresponding

page of the SIMARIS w ebsite to dow nload the update package and install it afterw ards. The w ebsite w hich provides updates for the SIMARIS

planning tools can also be directly accessed using this link w w w .siemens.com/simaris/update 

n If  you w ant to install or uninstall more technology packages (countries) at a later date, you can do this using the SIMARIS DVD. Start setup.exe,

as described above, and then start the installation of SIMARIS project. A w indow  is displayed show ing w hich technology packages are

available and w here checkmarks are set for technology packages you have already installed. By setting or removing checkmarks, follow ed by

a click on the "Accept" button, you can install or uninstall technology packages. The information about available technology packages is

provided from the DVD and their setup is initiated from there, too. This also means that technology packages provided at a later date, i.e. w hich

are not saved on this DVD, cannot be found. Also please note that any updates released after technology package installation must be installed

separately, either online or using the Help menu  àStart Online Update or by dow nloading the update package for off line installation from

w w w .siemens.com/simaris/update, w hich you can also call up from the program using the Help menu  à Dow nload Update Package.

n Another option how  to install or uninstall more technology packages (countries) at a later date is using the Extras menu  à Regionalisation.

In this case, how ever, Internet connection is required. A w indow  is displayed show ing w hich technology packages are available. Checkmarks

are set next to those technology packages you have installed. Removing or setting checkmarks allow s you to uninstall or install technology

packages. In this case, information is retrieved online and the dow nload of the technology packages you w ant to install as w ell, so that this

procedure requires an Internet connection. In this case, too, please note that any updates released after technology package installation must

be installed separately, either online or using the Help menu  à Start Off line Update or by dow nloading the update package for off line

installation from the SIMARIS w ebsite w w w .siemens.com/simaris/update, w hich you can also call up from the program using the Help menu

 à Dow nload Update Package.
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1.3.2  Setup after download
n Request a dow nload link at w w w .siemens.com/simaris/dow nload by entering and sending your data. 
n The dow nload link w ill be sent to you by e-mail. Having dow nloaded the .zip f ile that can be accessed through this link, decompress it on the

hard disk of your computer and then start setup_sp40.exe.

n Follow  the instructions of the setup w izard.

n SIMARIS project can be set up as local installation only.

n The initally dow nloaded install package only comprises the basic package for installing SIMARIS project. In the process of the setup routine you

w ill be asked in one w indow  w hich technology packages (countries) you w ant to install. The country list on display is determined online, i.e. in

the background it is queried w hich technology packages are available. After you have ticked off the countries you require, the installation of

the desired technology packages is performed online, meaning these packages are dow nloaded during the setup process. Hence, to be able to

run setup, you also need an active Internet connection during the setup process.

n Please check after running setup w hether updates are available and install them if necessary. These updates w ill only install the part belonging

to the country packages already installed on your computer and the update routine must be performed after installing more technology

packages again. To check w ether an update is available, you can start a query via the Help menu  à "Start online-update" provided your

computer is connected to the Internet. Then you can directly install available updates online. Another option is to use the Help menu  à

"Dow nload Update Package" and access the corresponding page on the SIMARIS w ebsite, dow nload the update package from there and then

install it off line. The w ebsite providing updates for SIMARIS planning tools can also be accessed directly at w w w .siemens.com/simaris/update 

n If  you w ant to install or uninstall more technology packages (countries) later, you can do so using the Extras menu  à Regionalisation. In

this case, how ever, Internet connection is required again. A w indow  is displayed show ing w hich technology packages are available.

Checkmarks are set next to those technology packages you have installed. Removing or setting checkmarks allow s you to uninstall or install

technology packages. In this case, information is retrieved online and the dow nload of the technology packages you w ant to install as w ell, so

that this procedure requires an Internet connection. Please note that any updates released after technology package installation must be

installed separately, either online or using the Help menu  à Start Off line Update or by dow nloading the update package for off line

installation from the SIMARIS w ebsite w w w .siemens.com/simaris/update, w hich you can also call up from the program using the Help menu

 à Dow nload Update Package.

1.3.3  Registration and read-in of the licence key
n The softw are may be used in a demo mode for 20 days after its installation. Only those days are counted on w hich you actually open the

program. In order to be able to use SIMARIS project permanently, you must register on the Internet at w w w .siemens.com/simaris/register.

Please enter your data there and request a licence by submitting the form. This licence w ill then be sent to you by e-mail w ithin half an hour.

Please save the f ile w ith the extension .lic (= licence key) on your computer. 
n As long as the licence key has not been read in, you w ill be asked during every program start, w hether you w ant to read in the licence key

now  or respectively, w hether you w ould like to register now  or later. 

n Clicking the "Import licence key" button starts the import process of your licence key. The brow ser opens w here you can set the f ile path of

your licence key and select the licence f ile identif ied by the f ile extension .lic-sp. As soon as you open this f ile, the licence f ile is read in and the

program is started.

n Clicking the "Register now " button automatically opens the registration page for the SIMARIS tools provided you are online. How  to proceed

from there w as decribed in the previous section.

n Clicking the "Register later" button takes you straight to the program, but you w ill be asked about registration again during the next program

start.

n You can also initiate the licence key import w hile the program is running using the Extras menu  à"Licence".
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1.3.4  Setup and use of country-specific versions
n In the setup w izard, you can select technology packages you w ant to install from a list of countries. 
n On the one hand, this implies the language selection, because every country selection installs the national language and English as languages.

On the other hand, this also implies the installation of the technology package pertaining to the selected country, i.e. the product and systems

range available for the country, the technology w hich complies w ith the regulations and conditions of the respective country. It is possible to

select several countries, w hich is above all necessary if  you are editing projects for different countries, because you should, of course, edit

each project w ith the relevant technology package only. 

n If  you later w ant to edit a project for a country w hose technology package / language is not installed, you can do so w ithout any problems w ith

the help of the Extras menu  à "Localisation", or by restarting the installation, selecting another country or several more countries and thus

installing the required languages and technology packages. All installed countries and, if  a country w as selected, also the associated

languages are provided for selection in the program step Project Definition . How ever, any change of country selection requires a program

restart. Please note that in that case any available updates must also be reinstalled, since an update alw ays installs that part w hich belongs to

the country packages already installed on your computer. How  to check w hether an update is available and how  to dow nload and install it is

described in the section Setup from DVD  and Setup after dow nload  

n If  you have created a project in a specif ic country setting and open this project w hile have made a different country selection, you w ill be

informed that to open this project, your country setting must be adapted accordingly. This means that the country setting for a project cannot

be changed at a later stage.

n When editing projects for different countries, the national language and English are each provided for editing. This means, for example, that you

can edit the project in English, but you can change to the national language for documentation purposes. Or you can send the project f ile to the

respective country and the editor there can open and edit the project in his/her national language. 

12

17

5 6
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2  Program Interface and Structure
2.1  Overview of the program sequence
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2.2  Navigation bar / workflow bar
With the help of the navigation bar you can go to the desired program step by directly clicking it.

Project Definition

Under

you can f ind the subordinate project steps

, 

in w hich you can enter the project data and design the project structure from the various

systems.

System Planning

Under

you can f ind subordinate project steps

depending on the selected system, in

w hich you can plan the respective

system.

Medium-voltage sw itchgear is compiled in 

 

from the cubicles library.

Transformers, busbar trunking systems and single components are compiled under 

 

from device libraries or a catalogue.

Low -voltage sw itchgear is automatically configured after you have selected devices, w hen you

sw itch from "A Device List" to "B Front View " or can be configured directly in the program step "B

Front View ".

Low -voltage sw itchgear is automatically configured after you have selected devices, w hen you

sw itch from "A Device List" to "B Front View ".

Charging units for electric vehicles are selected in

using the available templates.

Budget

Under

you can f ind the subordinate project

steps, 

in w hich you can either send your project f ile to your SIEMENS consultant for budget price

calculation or calculate a budget yourself in the summary of the configured systems.
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Project output

Under

you get directly to the output screen

w ithout having to select a subordinate

project step.

For the entire project or individual systems you can create a document to be edited in your w ord

processing program and/or a tender specif ication text in German or English in GAEB90 or text

format. For sw itchgear, transformers and pow er distribution boards you can generate front

view s, and for sw itchgear and distribution boards also single-line diagrams in .dxf format.

2.3  Icon bars
2.3.1  Main window

New  project Delete

Open project

Only those projects can be opened w hich w ere created

w ith the same country setting as the one currently set. If

you w ant to open a project w ith a different country

setting, proceed as described in chapter Project menu

in this Help text.

Cut

Save project Copy

Save project as Paste

2.3.2  Graphic area

In the selection mode you can select required components 

(e.g. complete cubicles/sections, devices) in the graphic area.

In the area selection mode you can select several required components 

(e.g. complete cubicles/sections, devices) in the graphic area.

In the zoom mode you can zoom into a cut-out of the graphic.

By clicking the general view  button, the entire plant is show n in the graphic.

By clicking this button, the entire plant is displayed horizontally aligned.

By clicking this button, the entire plant is displayed vertically aligned.

By clicking this button, a small overview  w indow  opens, show ing w hich cut-out is currently displayed in the graphic. The cut-out

can also be moved directly in this w indow  to display the required cut-out in the graphic.

11
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2.4  Menu bar and key combinations

2.4.1  Project menu
In the Project menu, select 

n New project to create a new  project. 
n Open project to open an existing project w ith the

extension .sp.

n Save to save the current project.

n Save As... to save the current project in a freely selectable

project path under any name.

n Import from SIMARIS design... to import a SIMARIS design f ile

w ith the extension .sx.

n one of the projects last edited from the displayed listto

further edit it.

n Exit to close SIMARIS project.

n If  you try to open a project created w ith a different country

setting than the one currently set, an error message w ill be

displayed, since the country setting, and thus the technology

package, once selected w hen a project w as ceated, cannot

be changed any more in SIMARIS project later. 

n To be able to open the project, you must f irst choose the

regional settings in "1 Project Definition" at "B Project Data"

that match this project.

n If  they cannot be selected, you may possibly have to install a

matching technology package. The procedure how  to install

technology packages later is explained in chapter Setup after

dow nload  and Setup from DVD  in this Help text.

2.4.2  Edit menu
The options Cut, Copy, Paste and Delete can be found in the Edit menu and also under the same icons in the

icon bar of the main w indow .

6 5
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2.4.3  Extras menu
In the Extras menu, select 

n Localisation (Regionalisation) to add or remove technology packages for different countries. 

Installation/uninstallation of technology packages is performed dependent on your selection, as soon as

you click the "Apply" button.

n Licence to check your licence status, or to import a new  licence. The licence f ile to be imported in SIMARIS

project comes w ith the f ile extension .lic-sp. 

n Settings to specify personal settings defined for SIMARIS project. A w indow  opens in w hich a tree is

displayed on the left w ith the user preferences that can be set:

- If  "Wizards" is selected, the right part of the w indow  provides the option for enabling or disabling

w izards. This means by removing the checkmark, you can deliberately disable automatic distribution

board configuration for certain plant types and enable it later, or enable it for a different project.

- When selecting "Notif ication service", it is possible to enable or disable the notes below  the navigation

bar.
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- When selecting "Update Settings" you can enable or disable the option to check for updates

automatically upon every program start.

n Show SIMARIS design Import Log to check the import of a project from SIMARIS design. A complete log

is generated in w hich you can check w hich devices w ere imported, for example, w hether the order

number w as perhaps adjusted for some devices, or w hether no suitable device might have been found. 

n Open GAEB Error Log in order to be able to understand errors during specif ication text export in the

GAEB format, if  any. This menu item provides the option to export errrors int a log f ile, it is therefore

irrelevant as long as no such error logs exist.
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2.4.4  Help menu
In the Help menu you can use these menu items to do the follow ing:

n Help to open this document to get informed about details of program

use and handling w hile the program is running. 
n Tutorial to start a presentation w hich is divided into several

chapters and many graphic diagrams and brief explanantions giving

you an overview  of the program functions.

n Technical manual to open a PDF file that provides complementary

technical information about SIMARIS design and SIMARIS project. 

n Open Demo Project to load a demo project w hich includes demo

plants as examples for various plant types.

n http://w w w .siemens.com/specif ications to call up the w ebsite

w hich provides tender specif ication texts for dow nload.

n Export Error Log(s) to export a log in case of error,w hich might be

useful for error clarif ication.

n Start online-update to check w hether an update is available for

SIMARIS project andto directly install it online 

n Download update package to dow nload an update as

compressed f ile (.zip f ile), then decompress and install it.

n What's new? to open a w indow  w hich lists all data and function

updates and changes since the last main version and all installed

hotf ixes and updates together w ith a brief description.

n Info to open a w indow  to obtain information about the version

installed on your computer including the verisons of all installed

components as w ell as about the data of the licence key you

currently use.

2.4.5  Corresponding key combinations
Project menu Save settings Ctrl + S

 + 

Edit menu Cut Ctrl + X

 + 

Copy Ctrl + C

 + 

Paste Ctrl + V

 + 

Delete Del

http://www.siemens.de/ausschreibungstexte
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3  First Start
3.1  Call start wizard

When you start the SIMARIS project softw are, the start w izard opens

automatically.

3.1.1  Create new project
Select "Create a new  project". 

Clicking "Next" opens the w indow  for the project data.

Enter the project data here. The entry of a project name is mandatory (default

entry is "new "), the entry of any other project data is optional.

With "Next" you are requested to save the project in a user-configurable

project path.

Clicking "Finish" saves the project f ile.
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3.1.2  Import from SIMARIS design
Select "Import from SIMARIS design" in the start w izard and then "Brow se..." to select a SIMARIS design f ile w ith the extension .sx. By clicking the

"Finish" button, the SIMARIS design f ile is imported.

3.1.3  Open existing project
Select "Open existing project" in the start w izard and then "Brow se..." to select a SIMARIS project f ile w ith the extension .sp. By clicking the

"Finish" button the SIMARIS project f ile is opened.

When a project is imported w hich w as created w ith a previous version of SIMARIS project, a backup f ile w ith the same name but a different

extension is created. This f ile extension contains the version number of the SIMARIS project version in w hich the project w as created. This

enables you - if  required - to post-edit the project again w ith the previous version on the basis of this f ile status.

n If  you try to open a project created w ith a different country setting than the

one currently set, an error message w ill be displayed, since the country

setting, and thus the technology package, once selected w hen a project

w as ceated, cannot be changed any more in SIMARIS project later. 

n To be able to open the project, you must f irst choose the regional settings

in "1 Project Definition" at "B Project Data" that match this project.

n If  they cannot be selected, you may possibly have to install a matching

technology package. The procedure how  to install technology packages

later is explained in chapter Setup after dow nload  and Setup from DVD

 in this Help text.

3.1.4  Load demo project
Select "Load the demo project" in the start w izard. By clicking the "Finish" button the demo project is opened.

3.1.5  Tutorial
As soon as you click the "Show " button below  Tutorial in the start w izard, a presentation is started w hich gives an introduction and overview  of

how  to handle the program.

You can also call up the Tutorial w hile you are using the program. To do so, use the Help menu  à "Tutorial".

6

5

14
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4  Project Definition
After a project w as loaded or created and the start w izard completed, you w ill automatically be taken to program step "1 Project Definition".à "B

Create Project Structure". In order to be able to view  data kept in the project definition from other editing steps, or to complete and change them,

click

 

on the navigation bar and choose - depending on w hether you w ant to edit the project data or the project structure - "A Project Data" or "B Project

Structure".

4.1  Project data
Below  you w ill f ind an overview  of how  to edit project data and the content available on this w indow .

In an existing project, the master data, customer data and comment can be

completed and changed under 

 at the top left.

Localised settings of SIMARIS project are show n in the Project Definition at the

botton left and can be adapted there. They are closely linked to the installed

country packages. This means that by selecting a country, the associated

technology package, w hich comprises the products suitable and regionally

available for the installation methods of the respective country, is used for

configuration, too.

The national language and English can be set for every country.

Changing the language and/or the country only becomes effective after a restart

of SIMARIS project.

To this date, 12 countries w ith a total of 8 languages can be installed and set for

SIMARIS project. A detailed list of all of the available country settings is displayed

in the setup and can be view ed online at w w w .siemens.com/simaris.

http://www.siemens.com/simaris
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On the right part of the

screen, you can display an

overview  of electrical pow er

distribution in buildings (for

infrastructure and industrial

projects) by clicking the

lettering "Totally Integrated

Pow er", w hich includes a

schematic graph of various

components and brief

explanations for each

component that are show n

as soon as you hover the

mouse pointer over one of

the components.

In addition, both the graphic

elements and the texts in the

list on the right are linked to

product pages of the

components, so that you can

easily start a more

comprehensive product

search from the program.
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Whereas an overview  of the

program w orkflow  is

displayed if you hover over

the lettering "Short

introduction".



20

4.2  Create project structure
The follow ing is a definition of the terms used in the individual areas of the user interface of the project structure.

         Systems library 

 Project tree 

         Favourites  Data of the selected system 
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Under 

 

you can select the systems required for

the project structure.

n To add a system, 
- select the system in the systems library and drag it to the project tree by keeping the left

mouse button pressed, 

- or double-click the required system in the systems library 

- Then further define the required features in the system-specif ic w izard for specif ication.

n To cut, copy or delete a system,

- right-click the required system in the project tree and select "Cut", "Copy" or "Delete" from

the context menu, 

- or select the system in the project tree and then select the corresponding icon  , 

or  from the icon bar, or choose from the Edit menu à "Cut", "Copy" or "Delete" on the

menu bar.

n To paste a system after having cut or copied it, 

- right-click the desired position in the project tree and select "Paste" from the context menu,

- or select the desired position in the project tree and then select the icon or in the menu

bar in the edit menuà "Paste" on the menu bar.

n If  a system in the project tree is marked by the yellow  icon , characteristics are missing for

the specif ication. 

To enter these,

-  double-click the selected system in the project tree and then select in the follow ing

w indow s - stepw ise, if  necessary - the missing characteristics w hich are also marked by

the yellow  icon, either by entering them or using the drop-dow n menu, 

- or select the system in the project tree and then click "System Planning" in the navigation

bar so that you can select the missing characteristics in the same w ay.

n Users of SIMARIS Configuration Advanced (SIMARIS CFA) can export a SIVACON S8 low -

voltage sw itchboard from SIMARIS project in order to edit it further in SIMARIS CFA. To do so,

select the plant in the project tree and start the export using the context menu (right mouse

button) by choosing "Export S8 à SIMARIS CFA".

4.3  Handling of systems in the project structure
n When a system is added to the project tree, the w indow s for selecting the desired system as w ell as for entering master data and system

characteristics are opening one after the other. 
n When clicking the "Finish" button in the system characteristics w indow  w ithout having completely f illed the characteristics, you w ill remain in

the program step Project Definition and can add further systems to the project tree. Nevertheless, the system remains marked by , because

specif ication characteristics are missing. The w indow  for entering the missing characteristics can be opened again by double-clicking the

marked system in the project tree.

n When clicking the "Finish" button after having completely selected the required characteristics, you w ill automatically be taken to the program

step System Planning. There you can select the required transformers, cubicles, devices, etc. from the templates or libraries depending on the

selected system type. How  to handle the various system types in the program step System Planning is described in the follow ing chapter.

n The system data entered during the creation of the system can be seen and also changed on the bottom right in the "Plant data" area. To this

end, select the required system in the project tree so that the data of the selected system is displayed and then make your changes in the

corresponding f ields, e.g. the system name or comment.
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4.3.1  Create new medium-voltage switchgear
n When new  medium-voltage sw itchgear is created, the w indow  for the

system selection opens f irst 
n Only those systems are displayed that match the set country selection.

This means, the technology package for a country w ill offer only those

systems for selection w hich are compatible w ith applicable regulations

of this country and are also available there.

n By clicking the "Next" button you get to the w indow  for entering the

plant master data. Since this w indow  looks the same for all systems, it

is show n as an example here and w ill not be show n any more for the

follow ing system types. 
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n By clicking the "Next" button, you get to the w indow  for selecting the

system characteristics. 
n Having selected all relevant data, click the "Finish" button to get to step

"2 System Planning". If  you didn't select all system data that is relevant,

you w ill remain in step "1 Project Definition".

n When 8DJH or SIMOSEC medium-voltage sw itchgear is selected, you

can call up more information using the info button next to the f ield

"Capacitive voltage detector systems", w hich you can also f ind in the

corresponding section of the Technical Manual. It can be accessed

using the Help menu  à "Technical manual".

4.3.2  Create new transformer
n When creating a new  transformer, the w indow  for the system selection

opens f irst. 
n Only those systems are displayed that match the set country selection. This

means, the technology package for a country w ill offer only those systems

for selection w hich are compatible w ith applicable regulations of this country

and are also available there.

n After selection of the system matching your application case, a click on the

"Next" button takes you to the w indow  for entering the plant master data (see

similar w indow  above: "Create new  medium-voltage sw itchgear" ).

14
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n By clicking the "Next" button, you get to the w indow  for selecting the system

characteristics. 
n Having selected all relevant data, click the "Finish" button to get to step "2

System Planning". If  you didn't select all system data that is relevant, you w ill

remain in step "1 Project Definition".

4.3.3  Create new low-voltage switchboard
n When a low -voltage sw itchboard is created, the w indow  for system

selection is displayed f irst. 
n Only those systems are displayed that match the set country selection. This

means, the technology package for a country w ill offer only those systems

for selection w hich are compatible w ith applicable regulations of this country

and are also available there.

n After selection of the system matching your application case, a click on the

"Next" button takes you to the w indow  for entering the plant master data

(see similar w indow  above: "Create new  medium-voltage sw itchgear" ).

n Clicking "Next" takes you to the w indow  for selecting plant characteristiscs.  
n Having selected all relevant data, click the "Finish" button to get to step "2

System Planning". If  you didn't select all system data that is relevant, you w ill

remain in step "1 Project Definition".

n The info button next to the f ield "Arc resistance level" allow s you to call up

more information, w hich you can also f ind in the corresponding section of

the Technical Manual. It can be accessed using the Help menu  à

"Technical manual".

n Users of SIMARIS Configuration Advanced (SIMARIS CFA) can export a

SIVACON S8 low -voltage sw itchboard from SIMARIS project in the "Project

Structure" step in order to further edit it in SIMARIS CFA. To do so, select the

plant in the project tree and start the export from the context menu (right

mouse button) by selecting "Export S8 à SIMARIS CFA".

22
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4.3.4  Create new busbar trunking system
n When creating a new  busbar trunking system, the w indow  for the system

selection opens f irst. 
n By clicking the "Next" button, you get to the w indow  for entering the master data

on the system (similar w indow  see above at "Create new  medium-voltage

sw itchgear" ).

n By clicking the "Next" button, you get to the w indow  for selecting the busbar

material, the conductor configuration and the required functional endurance

category. 
n Note: Functional endurance can only be factored in for busbar systems for

pow er transmission in SIMARIS project, meaning only the BD2, LD and LX

systems. If you have previously selected another busbar system for the

respective line, your selection for the functional endurance category w ill

automatically be defaulted as "w ithout" and cannot be changed.

n By clicking the "Next" button, you get to the w indow  for selecting more busbar

trunking system characteristics. 
n Having selected all relevant data, click the "Finish" button to get to step "2

System Planning". If  you didn't select all system data that is relevant, you w ill

remain in step "1 Project Definition".

n If  a functional endurance category w as selected in the previous w indow , the

rated current values offered for selection in this w indow  w ill be adjusted

corresponding to the required derating. 

22
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4.3.5  Create new distribution board
n When creating a new  distribution board, the w indow  for the system selection

opens f irst. 
n Only those systems are displayed that match the set country selection. This

means, the technology package for a country w ill offer only those systems for

selection w hich are compatible w ith applicable regulations of this country and

are also available there.

n By clicking the "Next" button, you get to the w indow  for entering the master

data on the system (analogue w indow  see above at "Create new  medium-

voltage sw itchgear" ).

n By clicking the "Next" button, you get to the w indow  for selecting the system

characteristics. 
n The spare space required as w ell as the space reserve for the terminal area

are specif ied as a percentage value, w hich is factored in the device list and

for automatic placement.

n Having selected all relevant data, click the "Finish" button to get to step "2

System Planning". If  you didn't select all system data that is relevant, you w ill

remain in step "1 Project Definition".

4.3.6  Create charging unit for electric vehicles
n When a new  charging unit for electric vehicles

is created, the w indow  for the system

selection opens f irst. 
n Only those systems are displayed that match

the set country selection. This means, the

technology package for a country w ill offer

only those systems for selection w hich are

compatible w ith applicable regulations of this

country and are also available there.

n By clicking the "Next" button, you get to the

w indow  for entering the master data on the

system (similar w indow  see above at "Create

new  medium-voltage sw itchgear" ).

22
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n By clicking the "Next" button, you get to the

w indow  for selecting the system

characteristics. 
n Having selected all relevant data, click the

"Finish" button to get to step "2 System

Planning". If  you didn't select all system data

that is relevant, you w ill remain in step "1

Project Definition".

4.3.7  Create new single components
n When a single component is created, the w indow  for entering the

master data for the plant is opened directly. 
n By clicking the "Finish" button, you get to step "2 System

Planning". 
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4.4  Favourites
n It is possible to save favourites for each available system type, w hich

can later be integrated in projects to be edited. 
n To do so, you must f irst create a folder on a drive you can access,

w here you w ant to save your Favourites. But you can also use the

"My Library" folder created during setup. If  several users shall be

enabled to access the saved Favourites, corresponding folder may

also be created on a server drive accessible to them.

n By clicking the  icon you can define the desired / this folder as

storage location in the explorer.

n You can now  save individual systems from each edited project as

favourites by selecting a system w ith the left mouse button, dragging it

to the list of favourites keeping the left mouse button pressed and

dropping it there by releasing the mouse button. The system is then

added to the alphabetically sorted list.

n In the corresponding folder on the drive, you can identify the f iles

containing favourites by the f ile extension .spx.

n If  you w ant to delete or rename systems from the Favourites folder,

you have to do that directly in the created folder on the drive.

Subsequently, you can update the list of favourites displayed in

SIMARIS project by clicking the  icon.

n To integrate the saved favourites in a project to be edited, select the

desired favourite w ith the left mouse button, drag it to the desired

position in the project tree by keeping the left mouse button pressed

and place it there by releasing the left mouse button.

n If  you w ant to transmit plants created using favourites to other project

editors w ho don't have access to a possibly shared Favourites folder

on a server (see above), you can copy the f iles from the Window s

Explorer and send them by e-mail. The recipient can save the

favourites f iles in his/her local Favourites folder and then integrate

them into his/her projects.
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5  System Planning
5.1  User interface variants in system planning
5.1.1  Overview of the front view
The follow ing is a definition of the terms used in the individual areas of the Front View  user interface in System Planning.

This user interface is available for medium-voltage sw itchgear, low -voltage sw itchboards, distribution boards, and charging units for electric

vehicles.

                                                Front view 
 

  Library 

Properties
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5.1.2  Overview of the device list
The follow ing is a definition of the terms used in the individual areas of the Device list user interface in System Planning.

This user interface is available for low -voltage sw itchboards and distribution boards.

         Library                          Device list 

 Properties 
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5.1.3  Overview of the component list
The follow ing is a definition of the terms used in the individual areas of the Component list user interface in System Planning.

This user interface is available for transformers, busbar trunking systems and single components.

In case of single components, the top left area displays a catalogue tree for device type selection. At bottom left you w ill f ind specif ic product

features for selection depending on the device type in order to specify these components in detail.

         Library                          Component list 

 Properties 
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5.2  Messages
5.2.1  Hints

Below  the navigation bar, comments are displayed. Here you are informed on w hat you can/should do next.

Informatio

n

Warning

Conflict

5.2.2  Input request
When a component, e.g. in the Component list, is marked by the yellow  icon,  this means that specif ication characteristics are missing. To enter

these, f ill in the input f ields in the Properties area (below ) also marked by the yellow  icon.
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5.3  Handling of system planning
5.3.1  Handling of medium-voltage switchgear

The Front View  user interface is your only w orkflow  area for creating new  medium-voltage sw itchgear.

In the headline of the library you f ind the icon 

 to can call up further information about the panels you can select in the library.

More information about medium-voltage sw itchgear, e.g. about cubicles (panels), protective devices and capacitive voltage detecting systems

and about the typif ication of circuit-breakers in medium-voltage sw itchgear you can call up via the info-button above the library, or can be

found in the corresponding sections of the Technical Manual w hich can be accessed using the Help menu  à"Technical manual".

Add new  cubicle n Select the desired cubicle in the library and drag it to the graphic area keeping the left mouse

button pressed, 
n or double-click the desired cubicle library (left) to transfer it to the graphic area automatically.

Move cubicle n Select the section in the graphic area and move it to the desired position keeping the left mouse

button pressed. 

Cut, copy, delete

cubicle

n Right-click the desired section in the graphic area or select several cubicles and then select

"Cut", "Copy" or "Delete" from the context menu 

n or select one or several cubicle(s) and then select the corresponding icon  ,  or 

or in the menu bar in the edit menuà "Cut", "Copy" or "Delete" on the menu bar.

Paste cubicle again after cut or copy n Right-click the desired position in the graphic area and select "Paste" from the context menu 

n or, on the icon bar, select the icon or in the menu bar in the edit menuà "Paste" on the

menu bar.

Change cubicle name n Select the cubicle and overw rite the corresponding input f ield in the "Properties" area. 

Change technical data of a cubicle n Select the cubicle, click in the desired input f ield in the "Properties" area   and select the

desired data item from the drop-dow n menu. 
n If  current and voltage transformers are selected, more data f ields w ill displayed for

specif ication depending on your selection, w here appropriate data must be selected, unless

they are set w ith default values.

Particularites of combined cubicles n Combined cubicles can only be cut, copied or deleted completely. 
n To change the arangement w ithin a combined cubicle, the entire cubicle must be selected and

adjusted accordingly in the data f ield "Arrangement of f ields" (= cubicle arrangement) in the

Properties section below  the graphic area.

n The properties of the combined cubicle w ill be show n in the "Properties" section below  the

graphic area, as soon as the combined cubicle is selected as a w hole. The properties of parts

of the cubicle w ill be show n in the "Properties" below  the the graphic area, as soon as a part

of a cubicle is selected. 

14
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5.3.2  Handling of transformers
The "Component list" user interface is your only w orkflow  area for selecting one or more transformer(s).

Add new  transformer n Select the desired transfomer in the library and drag it to the component list keeping the left

mouse button pressed, 
n or double-click the desired transformer in the library to add it to the component list

automatically.

n You can add several transformers. 

Move transformer n Select the transformer in the component list and move it to the desired position keeping the left

mouse button pressed. 

Cut, copy, delete transformer n Right-click the desired transformer in the parts list or select several transformers and then

select "Cut", "Copy" or "Delete" from the context menu 

n or select one or several transformer(s) and then select the corresponding icon  ,  or

or in the menu bar in the edit menuà "Cut", "Copy" or "Delete" on the menu bar.

Paste transformer again after cut or copy n Right-click the desired position in the project tree and select "Paste" from the context menu 

n or select the icon or in the menu bar in the edit menuà "Paste" on the menu bar.

Enter quantity n If  you need several identical transformers, you can enter the desired Quantity in the

"Properties" section (bottom) in the corresponding input box, or overw rite the respective f ield

in the "Quantity" column in the list of plants. 
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5.3.3  Handling of low-voltage switchboards

5.3.3.1  Device list

Select the required devices in the "Device list" user interface. 

Attention: Always select a feed-in circuit-breaker first! It w ill be listed accordingly in the "Infeed/Coupling" column.

More devices selected as infeed or coupling w ill automatically be listed in the "Infeed/Coupling" column.

More devices selected as feeders and reactive pow er compensation units w ill automatically be listed in the"Feeder" column.

This is necessary so that different busbar sections w ithin a plant can be properly detected and processed during automatic configuration.

More information about low -voltage sw itchboards, e.g. cubicles, forms of internal separation, connection options through busbars and cables,

electronic overcurrent tripping units (ETU) for 3WL circuit-breakers and the arc resistance levels you can call up via the info-button above the

library, or can be found in the corresponding chapters of the Technical Manual for the SIMARIS planning tools w hich can be accessed using

the Help menu  à "Technical manual".

Add new  device n Please always select a feed-in circuit-breaker

first!  
n Select the device from the library and drag it to the

appropriate column - "Infeed/Coupling" or "Feeder" in

the Device list - keeping the left mouse button pressed,

 
n or double-click the desired device in the library (left) to

transfer it to the device list automatically.

n The quantity to be selected for feed-in sw itches and

couplings can onyl be "1" (couplings simultaneously

serve as busbar disconnectors

Move device w ithin the list n Select the device in the device list and move it to the

desired position keeping the left mouse button

pressed. 

Cut, copy, delete device n Right-click the desired device in the device list or

select several devices and then select "Cut", "Copy"

or "Delete" from the context menu 
n or select one or several device(s) and then select the

corresponding icon  ,  or or in the menu

bar in the edit menuà "Cut", "Copy" or "Delete" on the

menu bar.

Paste device again after cut or copy n Right-click the desired position in the device list and

select "Paste" from the context menu 

n or select the icon or in the menu bar in the edit

menuà "Paste" on the menu bar.

Enter quantity n Select a device and enter the desired quantity in the

corresponding input f ield in the "Properties" area 
n or click the desired line in the "Quantity" column and

change the quantity there.

Change device name n Select the desired device and overw rite the name in

the "Name" input f ield in the "Properties" area. 

The yellow  marking in the device list indicates devices w hich have not yet been

placed.

n If  there are yellow  markings in the device list, this

means that these devices have not yet been placed in

distribution boards. 
n To place these devices plus matching assembly kits in

distribution boards, please trigger automatic creation of

the front view  by clicking   and

continue as described in the follow ing section 

Automatic creation of the front view .

n If  you don't w ant to overw rite the front view  you

created and perhaps post-edited, because you w ould

have to repeat post-editing, you can also directly place

devices graphically in the "Front View ", as described

in section Editing the front view .

14
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5.3.3.2  Automatic creation of the front view

To create the front view , select the devices and then click 

n If  a front view  is already available, the follow ing w indow  is displayed. 
n Clicking "Next" overw rites the existing front view  and an automatic

placement creates a new  front view  of the distribution board. 

n Clicking "Cancel" displays the existing front view . 

n Using the Extras menu  à settings, you can deliberately sw itch off

automatic configuration in the "Wizard" by disabling it for the respective

plant (untick the checkbox). 

n To create the front view , the spare space has to be specif ied. The

default spare space can be adapted in the follow ing w indow  w hich

opens automatically, as soon as the already existing front view  is

dismissed by clicking the "Next" button and a new  front view  is created.

To this end, click the corresponding input f ield and change the numeric

value there. This input is not applied as default but has to be entered

upon every new  creation of the front view . 

5.3.3.3  Editing the front view

This program step allow s to post-edit the front view  w hich w as automatically generated from the device list, or to directly create a plant

graphically.

In the library, you can f ind all device and cubicle variants that can also be selected using the device list and the automatic configuration of the

front view .

Additionally, there are more cubicles in the library for the SIVACON S8 low -voltage sw itchboard, w hich can only be selected in the "Front

view " program step, meaning they cannot be created in the "Device list" step. Please note, that these special cubicles must alw ays be placed

in the graphic view  after a repeated automatic configuration, since automatic configuration only considers devices from the device list and any

other manually placed cubicles w ill be deleted during the automatic configuration process.

More information about low -voltage systems, e.g. cubicles, forms of internal separation, connection options through busbars and cables,

electronic overcurrent tripping units (ETU) for 3WL circuit-breakers and the arc resistance levels you can call up via the info-button above the

library, or can be found in the corresponding sections of the Technical Manual for the SIMARIS planning tools w hich can be accessed using

the Help menu  à "Technical manual".

12
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n To add a cubicle to the graphic, please select the

required cubicle from the library and drag it to a

suitable position in the graphic area, keeping the left

mouse button pressed. Another option (w hich w ill

only w ork if  you didn't select a section in the

graphic area) is to double-click the desired cubicle

in the library, w hich w ill then be added to the

graphic area automatically. 
n To add devices w ith matching assembly kits to the

graphic, please select the required device from the

library and drag it to a suitable position in the

graphic area, keeping the left mouse button

pressed.

n Matching cubicles and devices can alw ays be

found in one category, so that you can easily f ind

matching devices for the selected cubicle.

n The devices selected in graphic area are assigned

as infeed/coupling or outgoing feeder in the device

list, too. This means that these devices w ill also be

considered during automatic reconfiguration, but

this automatic reconfiguration may result in a

different device arrangement than the graphic

placement you performed.
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n As already mentioned in the introduction to this

chapter, you can add more cubicles to the

configured plant in the graphic design in the "Front

View " step w hich you cannot create by device

selection in the "Device List" step. 

n In the "01_circuit-breaker design" category, a

transverse bus coupler cubicle is additionally

available for selection for the SIVACON S8 low -

voltage sw itchboard, provided that you selected

"Rear top and bottom" for the creation of the main

busbar position before.

n Please note, that these special cubicles must

alw ays be placed in the graphic view  again after a

repeated automatic configuration, since automatic

configuration only considers devices from the

device list and any other manually placed cubicles

w ill be deleted during the automatic configuration

process.

n Additional mixed cubicles "Withdraw able unit & in-

line sw itch disconnector horizontal" are available

for selection for the SIVACON S8 low -voltage

sw itchboard in the category "04_Withdraw able unit

design w ith front doors". In category "05_Fixed

mounted design w ith front doors", these are the

additional mixed cubicles "Fixed mounting & in-line,

plug-in design". 

n Please note, that these special cubicles must

alw ays be placed in the graphic view  again after a

repeated automatic configuration, since automatic

configuration only considers devices from the

device list and any other manually placed cubicles

w ill be deleted during the automatic configuration

process.

n Additionally, corner cubicles, empty cubicles, and

empty cubicles w ith busbar are available for

selection for the SIVACON S8 low -voltage

sw itchboard in the category "08_special cubicles". 

n Additionally, corner cubicles, cubicles w ith

mounting plate, and cubicles w ith a 19 inch

mounting frame are available for selection for

SIVACON S4 low -voltage sw itchboards (only

contained in technology packages for certain

countries) in the category "07_special cubicles".

n Additionally, corner cubicles and empty cubicles

are available for selection for SIVACON 8PT low -

voltage sw itchboard in the category "08_special

cubicles".

n Please note that you must manually place these

cubicles in the graphic again during repeated

automatic configuration, i.e. automatic placement,

since automatic configuration only factors in the

devices from the device list and any other manually

placed cubicles are deleted, w hen automatic

configuration is carried out.
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In order to further edit an automatically created or post-edited front view , this includes grafically created front view s, you can do the follow ing:

Move cubicle n Select a section in the graphic area and move it to

the desired position keeping the left mouse button

pressed. 

Cut, copy, delete cubicle n Select the desired cubicle(s) in the graphic area

and then select "Cut", "Copy" or "Delete" from the

context menu (right mouse button) 

n or one of the corresponding icons  ,  or

or in the menu bar in the edit menuà "Cut",

"Copy" or "Delete" in the Edit menu on the menu

bar.

n If  placed devices are deleted or cut together w ith

the cubicle, these devices are still contained in the

device list and marked in yellow  there, because

they are (now ) not placed in a cubicle. If  these

devices shall be completely deleted from the

configured plant, this must be done in the "Device

List" program step; if  they are to be kept, they must

be re-placed using automatic configuration or by

"Pasting" the cubicle at a different position.

Paste cubicle again after cut or copy n Right-click the desired position in the graphic and

select "Paste" from the context menu 

n or, in the icon bar, select the icon or in the

menu bar in the edit menuà "Paste" in the Edit

menu on the menu bar.

Move w ithdraw able unit n Select a w ithdraw able unit in the graphic and move

it to the desired position keeping the left mouse

button pressed. 

Cut, copy, delete w ithdraw able unit n Select the desired w ithdraw able unit(s) in the

graphic area and then select "Cut", "Copy" or

"Delete" from the context menu (right mouse

button) 

n or one of the corresponding icons  ,  or

or in the menu bar in the edit menuà "Cut",

"Copy" or "Delete" in the Edit menu on the menu

bar.

n If  placed devices are deleted or cut together w ith

the w ithdraw able unit, these devices are still

contained in the device list and marked in yellow

there, because they are (now ) not placed in a

cubicle. If  these devices shall be completely

deleted from the configured plant, this must be

done in the "Device List" program step; if  they are

to be kept, they must be re-placed using automatic

configuration or by "Pasting" the w ithdraw able unit

into a different cubicle.

Paste w ithdraw able unit again after cut or copy n Right-click the desired position in the graphic and

select "Paste" from the context menu 

n or, in the icon bar, select the icon or in the

menu bar in the edit menuà "Paste".

Change / enter cubicle name n Select the desired cubicle and enter the desired

name in the "Name" input f ield in the "Properties"

area or change an existing name there. 



41

Change technical data of a cubicle n Select the cubicle and in the "Properties" area in

the input f ield 

- Connection type, click  and select the

cable or busbar trunking system from the drop-

dow n list

- Door stop, click  and select left or right from

the drop-dow n list 

- Internal separation, click  in the desired

input f ield in the "Properties" area and select

the desired data item from the drop-dow n

menu.

- Cubicle w idth [mm], click  and select the

desired w idth from the drop-dow n list.

Depending on the type of cubicle you may have more

options for change.

Attention: changes of the cubicle w idth must be re-

entered after an automatic placement, since this

automatic process resets all cubicle w idth values to

the default values.

The coloured markings on cubicles, assembly kits, or devices indicate the follow ing:

n Coupling cubicles placed as the f irst or last cubicle

of a plant are marked in red. They must be moved

to a different position w ithin the plant. 

 

n Overcrow ded cubicles are marked in red, the

surplus assembly kit is also show n in red, and

ow ing to the overlapping it looks darker. 

n In such a case, too, you w ill be informed about the

existing conflict in "Properties" section below  the

graphic area.
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n Assembly kits are marked in yellow , as long as not

all of the required features have been selected for

specif ication. To select these features, select the

respective assembly kit and select the missing

data in the "Properties" section show n below  the

graphic area. 

n Data f ields w hich still require selecting data are

marked w ith an orange rhombus. 

n Assembly kits are marked in red if  there is a

conflict.  
n If  you select the respective assembly kit, an

information about the conflict is given below  the

graphic area in "Properties". How ever, this conflict

cannot alw ays be solved by changing the data of

the assembly kit, other cubicle data may have to be

adjusted, too. To do so, select the cubicle, in

w hich the assembly kit is located, check the data

in "Properties" below  the graphic area and change

them if required.

n Similarly, there are also more markings and

messages for devices and assembly kits, e.g. if

placed devices overlap in assembly kits for

modular devices or if  these kits are overcrow ded. 
n In such cases, you must trace the notes w hich are

displayed either in the assembly kit properties or in

the cubicle properties and thus eliminate the

existing conflicts.
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5.3.4  Handling of a busbar trunking system
The "Component list" user interface is your only w orkflow  area for selecting a busbar trunking system.

More information about busbar trunking systems, e.g. a systems overview  and configuration rules, can be found in the corresponding

chapters of the Technical Manual w hich can be accessed using the Help menu  à "Technical manual".

n Here you can see the component list of a busbar

trunking system and the individual components

as an example. 

n To change the length of a busbar or the

component quantities, click the appropriate

line in the "Length / Quantity" column and change

the length / quantity by overw riting it. 

n It is also possible, for example, to enter the ratio

of vertical installation w ith regard to the total

length "busbar horizontal" by selecting the

corresponding line in the "Length / Quantity"

column. 
n Correspondingly, the quantity and length of

the remaining components  can be adapted in

the component list according to the project

requirements.

n If  "Functional endurance" w as selected for the

busbar line, the corresponding length of

promating w ill be automatically show n in the

Promat infomation of the component list.

Changing the length of the busbar line also

adjusts the length value for the promating. 
n But a shorter promating length may be chosen

than the length of the busbar line if  promating is

not required for the entire busbar line. As soon

as you have adjusted the length of promating

manually, an automatic adjustment of the length

of promating is no longer possible in case of a

length change of the busbar line. 
n If  promating is selected in the component list,

promat properties w ill be displayed below  the

component list. The data f ields for the "Price" and

the "Weight per m2" of the promating w ill be

displayed, too. Though they are set w ith default

values, they can be adjusted according to

requirements.

n Likew ise, you can decide w hether promating is

required for 2, 3, or 4 sides in the data f ield

"Number of casing sides" according to your

project requirements.

More information about the topic of functional

endurance and its consideration in SIMARIS project

can be found in the corresponding chapter of the

Technical Manual for the SIMARIS planning tools

w hich can be accessed using the Help menu  à

"Technical manual".

14
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Add tap-off unit n Select a tap-off unit in the library and drag it to the busbar in the parts list keeping the left

mouse button pressed. Then, select the missing technical data of the tap-off unit (input f ields

marked in yellow ) in the "Properties" area. 

Move tap-off unit n Select the tap-off unit in the component list and move it to the desired position keeping the left

mouse button pressed. 

Cut, copy, delete tap-off unit n Select the desired tap-off unit(s) in the component list and then select "Cut", "Copy" or "Delete"

from the context menu (right mouse button) 

n or one of the corresponding icons  ,  or or in the menu bar in the edit menuà
"Cut", "Copy" or "Delete" on the menu bar.

Paste tap-off unit again after cut or copy n Right-click the desired position in the systems tree of the component list and select "Paste"

from the context menu 

n or select the desired position and then select the icon  in the icon bar.

Add another busbar line n Select a busbar line in the library and drag it to the systems tree of the component list keeping

the left mouse button pressed. 

Delete busbar line n Select one or several busbar line(s) from the component list and select "Delete" 
from the context menu (right mouse button)

n or select the icon or in the menu bar in the edit menuà "Delete".

Complete a user-configurable component

list item

n Select "User-configurable component list item" in the library and drag it to the systems tree of

the component list keeping the left mouse button pressed. You then have to enter an order

number and further data for specif ication in the "Properties" area. 
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5.3.5  Handling of a distribution board

5.3.5.1  Device list

Select the required devices in the "Device list" user interface.

Add device n Select the device in the library and drag it to the device list keeping the left mouse button pressed. 

Move device w ithin the list n Select the device in the device list and move it to the desired position keeping the left mouse button pressed. 

Cut, copy, delete device n Right-click the desired device in the device list or select several devices and then select "Cut", "Copy" or

"Delete" from the context menu 

n or select one or several device(s) and then select the corresponding icon  ,  or or in the menu

bar in the edit menuà "Cut", "Copy" or "Delete"

Paste device again after

cut or copy
n Right-click the desired position in the device list and select "Paste" from the context menu 

n or select the icon or in the menu bar in the edit menuà "Paste" on the menu bar.

Add user-selectable device n Select "User-selectable device" in the library and add it to the device list. Enter an order number and the

w eight of the device in the "Properties" area. 

Enter quantity n The desired Quantity of a selected device can be entered  

Change device name n Select the desired device and change the name in the "Name" input f ield in the

"Properties" area. 

Automatic adaptation of the terminal connection

area

n When the quantity of a device is changed, the terminal connection area is

adapted automatically according to the default set during the plant creation (project

definition). 

Manual expansion of the terminal connection

area 
n Select "Terminal connection area" in the library and drag it to the device list.  

The yellow  marking in the device list indicates

devices w hich have not yet been placed.

n If  there are yellow  markings in the device list, this means that these devices have not

yet been placed in distribution boards. 
n To place these devices plus matching mounting kits in distribution boards, please trigger

automatic creation of the front view  by clicking  and continue as

described in the follow ing section Automatic creation of the Front View .

n If  you don't w ant to overw rite the front view  you created and perhaps post-edited,

because you w ould have to repeat post-editing, you can also directly place devices

graphically in the "Front View ", as described in section Editing the front view .

46
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5.3.5.2  Automatic creation of the front view

For automatic creation of the front view , click 

 

n If  a front view  is already available, the follow ing w indow  is displayed 
n Clicking "Next" overw rites the existing front view  and an automatic

placement creates a new  front view  of the distribution board. 

n The default spare space as w ell as the space reserve for the terminal

area are considered according to the specif ications made, w hen the

distribution board w as added in the project definition.

n Clicking "Cancel" displays the existing front view   

n Using the Extras menu  à settings, you can deliberately sw itch off

automatic configuration in the "Wizard" by disabling it for the

respective plant (untick the checkbox). 

5.3.5.3  Editing the front view

To edit the front view, the following options are provided:

Move cubicle n Select the section in the graphic area and move it to the desired position keeping the left mouse

button pressed. 

Cut, copy, delete cubicle n Select the desired cubicle(s) in the graphic area and then select "Cut", "Copy" or "Delete" from

the context menu (right mouse button) 

n or one of the corresponding icons  ,  or or in the menu bar in the edit menuà
"Cut", "Copy" or "Delete" on the menu bar.

n If  placed devices are deleted or cut together w ith the cubicle, these devices are still contained

in the device list and marked in yellow  there, because they are (now ) not placed in a cubicle. If

these devices shall be completely deleted from the configured plant, this must be done in the

"Device List" program step; if  they are to be kept, they must be re-placed using automatic

configuration or by "Pasting" the cubicle at a different position.

Paste section again after cut or copy n Right-click the desired position in the graphic area and select "Paste" from the context menu 

n or select the icon or in the menu bar in the edit menuà "Paste" in the Edit menu on the

menu bar.

Add new  device n Select a device in the library and drag it to the graphic area keeping the left mouse button

pressed. 

Move device n Select one or several device(s) in the graphic area and move it/them to the desired position

keeping the left mouse button pressed. 

Cut, copy, delete device n Select the desired device(s) in the graphic area and select "Cut", "Copy" or "Delete" from the

context menu (right mouse button) 

n or one of the corresponding icons  ,  or or in the menu bar in the edit menuà
"Cut", "Copy" or "Delete" on the menu bar.

n If  a placed device is deleted or cut, it is still contained in the device list and marked in yellow

there, because it is not placed in a cubicle. If  this device shall be completely deleted from the

configured plant, this must be done in the "Device List" program step; if  it is to be kept, it must

be re-placed using automatic configuration or by "Pasting" it into a different cubicle.

Paste device again after cut or copy n Right-click the desired position in the graphic and select "Paste" from the context menu 

n or select the icon or in the menu bar in the edit menuà "Paste" on the menu bar.

12
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Change / enter cubicle name n Select the desired section in the graphic area and enter the desired name in the "Name" input

f ield in the "Properties" area: 

Change w eight factor n The w eights of the distribution board and devices are added up automatically. The weights of

cables, terminals, etc. are taken into account proportionally via the w eight factor. To

change the weight factor, select the respective cubicle and change the w eight factor in the

corresponding input f ield in the "Properties" area (see graphic above). 

Select distribution board size n DIN system: When the front view  is generated, the distribution board size is determined

according to the selected devices. Any other distribution board added later, this also includes

empty distribution boards, is selected in the same size. If  you w ant to select a different 

distribution board size, you can specify the distribution board size in the plant's

"Properties" area by selecting a different value in the "Distribution board size (max. MW)" input

f ield. The plant properties are displayed if none of the cubicles is marked. To this end, left-click

into the w hite space outside the cubicles. As soon as you have defined the the distribution

board size by selecting an MW figure, the w idth and the height of the distribution board w ill

also be adjusted accordingly in the plant's "Properties" area. 
n NF system: When the front view  is generated, the distribution board size is determined

according to the selected devices. In case of an ALPHA 630 NF distribution board, the pre-

selection is alw ays a distribution board w ith a busbar compartment at the side and busbars at

the top. How ever, if  you w ant to create the distribution board w ithout busbars or w ith a

different installation of the busbars (e.g. busbar installation at the rear w all), you must make

the appropriate selection in the data f ields "Busbar", "Installation type" and "Width inside",

w hich may affect the w idth of the distribution board. Any other distribution board added later,

this also includes empty distribution boards, is selected in the same height. If  you w ant to

select a different height using Select distribution board height, you can specify the

distribution board height in the "Properties" section for the plant by selecting a different value in

the input f ield "Height outside". The plant properties are displayed if none of the cubicles is

selected. To this end, left-click into the w hite space outside the cubicles.

n If  a size adjustment of distribution boards in heigth or w idth means that previously placed

assembly kits/devices can no longer be placed, the entire distribution board or assembly kit is

marked in red, and supernumerous assembly kits or devices at the bottom left in the distribution

board are also show n in red. They can manually be moved to other empty spaces in other

distribution boards / assembly kits or they can be deleted.
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Add additional cubicles (empty

distribution boards)

n DIN system: Select an "empty distribution board" in the library and drag it to the graphic area. An

empty distribution board of the same size as the existing ones w ill be added. But you can select

a different w idth for this distribution board, by selecting this distribution board in the graphic

area and choosing a different w idth in the distribution board properties displayed below .  
n NF system: Select an "empty distribution board" in the library and drag it to the graphic area. An

empty distribution board of the same size as the existing ones w ill be added. But in case of an

ALPHA 630 NF distribution board, this w ill be a distribution board w ithout a busbar compartment

at the side. You can choose a different w idth and busbars as w ell by making the corresponding

selections in the f ields "Busbars", "Width inside" and "Installation type".

Add blanking strip, any devices, terminal

area, blanking cover and mounting kits

for meter manually

n Select the desired element in the library and drag it to the graphic area keeping the left mouse

button pressed. 
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5.3.6  Handling of charging units for electric vehicles
To select charging units for electric vehicles, you w ill only w ork in the Front View  user interface.

Add new  charging unit n Select the desired charging unit in the library (on the left) and drag it to the graphic area

keeping the left mouse button pressed  

Move charging unit n Select the desired charging unit in the graphic area and drag it to the desired position keeping

the left mouse button pressed 

Cut, copy, delete charging 

unit

n In the graphic area, right-click the desired charging unit, or select several charging units, and

select "Cut", "Copy" or "Delete" in the context menu. 
n Or, select one or more charging units and select one of the desired icons from the icon bar

 ,  or or in the menu bar in the edit menuà "Cut", "Copy" or "Delete".

Paste charging unit again after cut or

copy
n Right-click the desired position in the graphic area and select "Paste" from the context menu 

n or, select the icon on the icon bar or in the menu bar in the edit menuà "Paste".

Change name of charging unit n Select the charging unit in the graphic area and overw rite the corresponding input f ield in the

"Properties" area. 

Change technical data of a charging unit n Select the charging unit and click in the desired input f ield in the "Properties" area   and

select the desired data item from the drop-dow n menu. 
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6  Budget Determination
6.1  Budget inquiry
To determine a budget for the plants w hich you configured, please get in touch w ith your Consultant Promoter at Siemens. Send him your saved

project (f ilename.sp) by e-mail. You can f ind the contact person responsible for you at the follow ing Internet address:

w w w .siemens.com/simaris/contact. 

6.2  Budget summary
As of version 2.0, the program step "3 Budget" à "B Summary" includes a budget sheet w hich allow s you to compile a budget for configured

plants yourself.

This budget sheet lists all configured plants. The budget sheet comprises 2 lines for each plant.

In the f irst line, you can enter the respective plant costs. You then have the option to define an addition or reduction factor for each plant by

entering the required percentage in the same line and defining w hether it is an addition (+) or reduction (-) in the drop-dow n menu. This defined

addition or reduction is directly factored in the plant price. The result is show n in the same line in the right column named "Plant price".

In the next line, you can define another addition or reduction for this plant in the same w ay, w hich is, how ever, listed separately in this second

line of the "Plant price" column and not directly included in the plant price but only in the total sum of all plants. 

You can enter your ow n designations for the additions and reductions in the table.

http://www.siemens.de/simaris/kontakt
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7  Output and Data Transfer
7.1  Output types and options

General information

To prepare the output, select the plant(s) for w hich you w ant to

generate an output on the left in the project tree.

If you tick the top checkbox, all plants w ill be selected, if  you remove

your checkmark from the top checkbox, all checkmarks w ill be

removed from the plants.

An alternative w ay how  to select or deselect all plants is to open the

context menu w ith the right mouse button and make the respective

selection.

You can insert your own logo into the complete document by

clicking  at the top right. Then, select the desired logo using

"Brow se...".

Output of complete document

Start output
n To start the output, select  and click

 "Start Output". The complete document is output in a modif iable .rtf  format and automatically opens

your installed w ord processing program. The thus created f ile can then be saved; this can also be done

in the WORD format (.doc) w hich considerably decreases the f ile volume. 
n If  many plants have been selected for the output, the data output might take several minutes depending

on the processing pow er of your computer.

Extent n The complete output of the plants comprises a cover sheet,  
– a general description of the systems used in the project,

– technical data on the configured plants, for low -voltage sw itchboards and distribution boards also

including a heating estimation, 

– a cover sheet for each plant on the created view s,

– a front view  of the plants (only for medium-voltage sw itchgear, low -voltage sw itchboards and

distribution boards)

– a circuit diagram (single-line) (only for medium-voltage sw itchgear and low -voltage sw itchboards). 

– and a budget overview  including, if  applicable, prices, additions and reductions as calculated in step

"3 Budget"à "Summary". 

n Furthermore, the complete output comprises a disclaimer in w hich statements

– on disclaimers of liability

– for cost estimates

– on the project transfer from SIMARIS design

– on the front view s created

– on the circuit diagram (single-line) are made. 

n Finally, this output provides a list of relevant standards for the plants and devices configurable w ith

SIMARIS project.
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Output of plant views

You can also initiate the output of available plant view s, cover sheet, front view , and single line diagram separately. The view s can be output

individually or simultaneously in one document. Documents are created in DXF format and are at f irst displayed in a DXF view er. Files

generated in this w ay can then be saved. Files are saved from the DXF view er, either using "Save as" (see icon on the icon bar at the top

left), as DXF or DWG files, or they can be saved in the follow ing variants using the File menu:

à  Save copy

à Create PDF... 

à Convert draw ing (Dw g)...  

This means, draw ings can be saved in the DXF, DWG, or PDF format. In addition, there is the option (in the f ile menu) to choose w hether

individual, selected, or all draw ings shall be converted/saved.

For each selected plant, the follow ing output options can be selected and thus be integrated in the output.

Output cover sheet

n Select   and click  "Start Output". One sheet each is output

containing the technical data and comments (only for medium-voltage sw itchgear, transformer, low -

voltage sw itchboard, and distribution board). 

Output front view

n Select  and click  "Start output". A front

view  is output (only for medium-voltage sw itchgear, transformer, low -voltage sw itchboard, and

distribution board). 

Output circuit diagram (single-

line)
n Select  and click  "Start Output". A single-line diagram is output (only for the

medium-voltage or low -voltage sw itchgear).  

System draw ing (can only be

selected in the "China" country

setting).
n Select and click  "Start Output". A system draw ing is output (only for the medium-voltage or low -

voltage sw itchgear).  
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Create specification automatically

Another output variant is the creation of specif ications for configured plants. To do so, f irst select the plants for w hich a specif icaction is to be

generated in the project tree, then select the language in w hich the specif ication is to be output. You can choose betw een German and

English.

Create specif ication in GAEB

90, d81 format
n Select  and click "Start Output". A w indow  is opened

w here you can selected the desired storage location using the "Brow se..." button. In another w indow ,

you can enter the f ile name. After clicking "Save", you are taken back to the f irst w indow  w here you can

complete the process by clicking "Finish". Files in German language are automatically assigned the f ile

extension <file name>.d81 and f iles in English <file name>.x81. 

n This output variant is not available in the "China" country setting.

Create specif ication in .rtf

format
n Select   and click  "Start output". A w indow  opens

in w hich you can select the desired storage location via the "Brow se..." button and in another w indow

the f ile name. Then, click "Save" to return to the f irst w indow  in w hich you can complete the process by

clicking the "Finish" button. Files in German and English are automatically saved w ith f ilename.rtf. 
n In the .rtf  document that is generated, you can add a Table of Contents by selecting the follow ing text on

the second page of the document and pressing F9, or by selecting "Update Fields" from the context menu

using the right mouse button.

n This output variant is not available in the "China" country setting.

Select both output options

simultaneously

n In this case, location and name of the f iles to be created are queried one after another similar to the

procedure described above. 

Tender specif ication in .rtf

format for China.
n Select  and click "Start Output". An .rtf  document is

created w hich can be used for invitations to tender in China in combination w ith the system draw ing. 
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7.2  Data transfer
Data transfer for budgeting

To determine a budget for the plants w hich you configured, please get in touch w ith your Consultant Promoter at Siemens. Send him your

saved project (f ilename.sp) by e-mail. You can f ind the contact person responsible for you at the follow ing Internet address: 

w w w .siemens.com/simaris/contact 

Data transfer from SIMARIS design

To be able to establish the budget and space requirements for a pow er distribution system dimensioned using SIMARIS design, you can import

a corresponding export f ile from SIMARIS design (f ile_name.sx) into SIMARIS project. How ever, this is only possible w ith synchronized

versions of SIMARIS design and SIMARIS project, for example SIMARIS design 7 corresponds to SIMARIS project 3 and SIMARIS design 8 to

SIMARIS project 4.

To import a transfer f ile into SIMAARIS project, select "Import from SIMARIS design" in the start w izard during program start, or w hen the

program is already executed, use the Project menu à Import from SIMARIS design and then select a SIMARIS design f ile w ith the f ile extension

.sx by clicking the "Brow se" button. Clicking "Next" imports the SIMARIS design f ile and "Finish" generates the corresponding view s and lists.

Depending on the project size, this process may take some time.

On the basis of the data imported from SIMARIS design the required plants are generated directly, listed in the project tree and displayed as

component list or front view  in the program step "System Planning".

n "Components not recognized" w ill be listed accordingly in the project tree in step "1 Project Definition" under "B Create Project Structure". 
n Components w hich cannot be built into the distribution boards are listed under "Single components".

n Established protective devices in outgoing feeders located on busbars are transferred to matching tap-off units and thus listed in the

component list for the established busbar trunking systems.

Then, the individual, automatically generated plants can be post-processed as required.

If the program should f ind during data import that the present national setting in SIMARIS project is not compatible w ith the country setting in the

transfer f ile from SIMARIS design, a hint w ill be given and the option provided to adjust the country setting accordingly, before the import is

started.

If the transfer f ile is imported in SIMARIS project w ith a different country setting than the one set in the transfer f ile, products and systems are

implemented matching to the country selected in SIMARIS project - as far as possible. Devices w hich cannot be built into plants, because no

matching plants are available in this country setting, are listed in the project tree under "Single components".

Attention: In SIMARIS project, it is NOT possible to change the national setting again at a later stage of project editing!

If you also w ant to integrate the netw ork diagram created in SIMARIS design in the documention prepared in SIMARIS project, you can export

the netw ork diagram from SIMARIS design as .dxf f ile and then import it to the DXF view er in SIMARIS project, by dragging the saved f ile from

the Explorer to the open DXF view er.

http://www.siemens.de/simaris/kontakt
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8  Technical Background of the Systems
The follow ing is a short list of the Siemens systems stored in the current SIMARIS project version.

Corresponding short information is also available in the program in the program step  under

 

There you can move the mouse pointer over the list of the various systems on an abstract image of a building. Depending on the system you are

selecting, this is marked in the building and a brief description is displayed. 

If you need further information, click the respective system in the list below  the building. This w ill automatically lead you to the corresponding

Siemens Internet pages w ith the most recent information on this system.

8.1  Medium-voltage switchgear
The gas- and air-insulated, type-tested sw itchgear for primary and secondary distribution levels in the medium-voltage netw ork require little

space in the sw itchgear room and are manufactured as hermetically sealed pressure system in accordance w ith IEC 62271-200. They are

thus absolutely independent of external inf luences.

Since not all countries can be equipped w ith the same systems, matching systems are displayed for selection dependent on the country

setting you have chosen.

NX PLUS C n Gas-insulated for primary distribution level 
- Up to 24 kV / up to 31.5 kA / up to 2500 A 

- Type-tested, metal-enclosed, metal-separated, SF6-insulated 

- Compact and pow erful 

- Single and double busbar system 

- Can be installed and expanded w ithout any gas w ork

- Maintenance-free for lifetime 

- Hermetically w elded containers, gas-tight for lifetime

- Environmentally independent (dust, humidity, small animals)

8DJH and 8DJH compact n Gas-insulated for secondary distribution level 
- Up to 17.5 kV, 25 kA or 24 kV, 20 kA

- Busbar 630 A, feeders up to 630 A

- Factory-built, type-tested sw itchgear in accordance w ith IEC 62271-200

- Metal-enclosed

- Single busbar 

- Gas-insulated, tight for lifetime

- Flexible due to side by side arrangement and block form

- Individual panels and block versions

- Fully f lexible system concept – expandable to both sides w ith panels or blocks

- Sw itching devices and protection schemes optimised for each sw itching task
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8DJH36 n Gas-insulated for secondary distribution level 
- Up to 36 kV, 20 kA

- Busbar 630 A, feeders up to 630 A

- Factory-assembled, type-tested sw itchgear in accordance w ith IEC 62271-200

- Metal-enclosed

- Single busbar 

- Gas-insulated

- Hermetically sealed

- Side by side arrangement and expandable as one panel or panel block

SIMOSEC n Air-insulated for the secondary distribution level 
- Up to 12 kV, 25 kA or 17.5 kV, 25 kA or 24 kV, 20 kA

- Busbar up to 1,250 A, feeders up to 1,250 A

- Factory-built, type-tested sw itchgear in accordance w ith IEC 62271-200 

- Metal-enclosed

- Single busbar 

- Air-insulated technology combined w ith gas-insulated sw itching function

- Modular, compact design

- Individual panels and combined panels available

- Low -voltage cubicle can be integrated (in tw o of the available system heights)

NXAir (only China) n Air-insulated for the primary distribution level (only for use in China) 
- Max. 12 kV, 40 kA or 24 kV, 31.5 kA

- Busbar up to 3150 A or 4000 A, branches up to 3150 A or 4000 A

- Factory-built, type-tested sw itchgear in accordance w ithGB3906, DL404, IEC62271-200

- Metal-enclosed

- Single busbar 

- Air-insulated design combined w ith vacuum sw itching function

- Modular design

- Single cubicles

- Low -voltage cubicle can be integrated 

NXAIR n air-insulatedfor primary distribution 
- up to 17.5 kV, 50 kA resp. 24 kV, 25 kA

- busbar up to 3150 resp. 4000 A, feeders up to 3150 resp. 4000 A

- factory-assembled, type-tested sw itchgear in accordance w ith IEC 62271-200

- Metal-enclosed

- Single busbar 

- Air-insulated design combined w ith vacuum sw itching function

- Modular design

- Single cubicles

- Low -voltage cubicle can be integrated 



57

8.2  Transformers
GEAFOL cast-resin transformers

Wherever distribution transformers must ensure utmost safety in areas frequented by people or w hich require protection of w ater, Siemens

GEAFOL cast-resin transformers are the perfect solution.

Properties n High operating safety  
n Very good electrical, mechanical and thermal properties

n Hardly inflammable, self-extinguishing, no toxic gas emission in case of f ire 

n Vacuum casting of the high-voltage w inding allow s for a long lifetime because of freedom

from partial discharges up to tw ice the rated voltage 

n Particularly environmentally friendly and low -noise design, maintenance-free, no structural

requirements w ith regard to oil pan

GEAFOL transformers 4GB n Cast-resin transformers for highest requirements in terms of personal protection and f ire

load, suitable for operation in buildings w ithout additional measures 
n Variants provided in SIMARIS project:

- Apparent pow er from 250 kVA to 2,500 kVA

- Rated voltage (primary voltage) from 6 kV to 30 kV

GEAFOL basic transformers 4GT n Cast-resin transformers for highest requirements in terms of personal protection and f ire

load, suitable for operation in buildings w ithout additional measures, particularly economical 
n Variants provided in SIMARIS project:

- Apparent pow er from 630 kVA to 2,500 kVA

- Rated voltage (primary voltage) from 10 kV to 30 kV

GEAFOL 60 n Cast-resin transformers for highest requirements in terms of personal protection and f ire

load, suitable for operation in buildings w ithout additional measures 
n Variants provided in SIMARIS project (only for the Brazil country package):

- Apparent pow er from 75 kVA to 2,500 kVA

- Rated voltage (primary voltage) from 11.4 kV to 13.8 kV
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Oil transformers

On the last transformation stage from the pow er station to the consumer, distribution transformers provide the required energy for systems

and buildings. Therefore, they must not only operate reliably and economically but also silently. Siemens oil distribution transformers meet these

demands and are suitable for extreme climatic conditions and for installation in confined spaces – in distribution systems as w ell as in industrial

plants.

Properties n Excellent electrical, mechanical and thermal properties 
n Use of biodegradable cooling liquids

n Customized distribution transformers for almost every application and site

n Low  values of loss and noise emission due to the use of silicon-alloyed electrical sheets

Oil transformers hermetic 4HB n For cost-effective operation w ithout any specif ic requirements, maintenance-free 
n Variants provided in SIMARIS project:

- Apparent pow er from 50 kVA to 2500 kVA

- Rated voltage (primary voltage) from 10 kV to 20 kV

Oil transformers expansion tank 4JB n For cost-effective operation w ithout any specif ic requirements, higher thermal load 
n Variants provided in SIMARIS project:

- Apparent pow er from 50 kVA to 2500 kVA

- Rated voltage (primary voltage) from 10 kV to 20 kV
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8.3  Low-voltage switchboards
When planning w ith SIMARIS project, the SIVACON S8 pow er distribution board, SIVACON S4 and SIVACON 8PT  (only for China) 

Since not all countries can be equipped w ith the same systems, matching systems are displayed for selection dependent on the country

setting you have chosen.

SIVACON S8 The SIVACON S8 low -voltage sw itchboards provide the optimum of plant safety thanks

to pow er sw itchgear and controlgear (PSC) assemblies verif ied by type test. They

ensure maximum personal safety ow ing to an arc fault proof door lock system. Devices

can quickly be accessed for adjustments. The system includes a highly eff icient

ventilation system w ith maintenance benefits.

Properties

n Standards and regulations:  
PSC pow er sw itchgear and controlgear assembly in accordance w ith IEC 60439-1,

EN 60439-1

Protection against electric shock in accordance w ith DIN EN 50274

Testing under conditions of arcing due to an internal fault in accordance w ith IEC

61641

n Clearance and creepage distances:

Rated impulse w ithstand voltage (Uimp) 12 kV

Overvoltage category IV

Degree of pollution 3

n Rated insulation voltage Ui 1000 V, 50 / 60 Hz

n Rated operating voltage Ue up to 690 V

n Busbars 3-pole / 4-pole:

Main busbar at rear top

Rated currents In up to 7000 A

Rated peak w ithstand current Ipk up to 330 kA

Rated short-time w ithstand current ICW up to 150 kA, 1 s

n Degree of protection in accordance w ith IEC 60529, EN 60529 up to IP 55

n Form of internal separation in accordance w ith IEC 60439-1, EN 60439-1, Para. 7.7

up to form 4

Available mounting techniques

n Circuit-breaker panel w ith SENTRON 3WL up to 6300 A or 3VL up to 1600 A 
n Universal installation technology panel for motor and cable feeders up to 630 A in

w ithdraw able unit design w ith combination options w ith f ixed-mounted design

(compartment door) and in-line design 3NJ6 (plug-in)

n Panel for frequency converter, CEP and changeover

n In-line design 3NJ6 (plug-in) for cable feeders up to 630 A in plug-in design

n Fixed-mounted panel (front panel) for cable feeders up to 630 A and modular

installation devices

n In-line design 3NJ4 (f ixed-mounted) for cable feeders up to 630 A

n Reactive pow er compensation up to 600 kvar

SIVACON S4 SIVACON S4 is apow er sw itchgear and controlgear (PSC) assembly verif ied by type

test.w hich is used in infrastructural supply in administrative and functional buildings, in

the industry as w ell as in commercial buildings and public buildings like schools and

hospitals. The concept of the SIVAACON S4 low -voltage pow er distribution board is

characterized by a high degree of personal and plant safety.

This plant is only available for the follow ing country settings: Brazil, China, the

Netherlands, Austria, Poland, Portugal, Spain.

Properties

n Standards and regulations:  
pow er sw itchgear and controlgear (PSC) assembly in accordance w ith IEC 60439-

1/2, EN 60439-1/2

Protection against electric shock in accordance w ith DIN EN 50274

Testing under conditions of arcing due to an internal fault in accordance w ith IEC

61641

n Clearance and creepage distances:

Rated impulse w ithstand voltage (Uimp) 12 kV

Overvoltage category IV

Degree of pollution 3

n Rated insulation voltage Ui 1000 V, 50 / 60 Hz

n Rated operating voltage Ue up to 690 V
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n Busbars 3-pole / 4-pole:

Horizontal main busbars 

Rated currents Inmax. 4000 A

Rated peak w ithstand current Ipkmax. 220 kA

Rated short-time w ithstand current ICWmax. 100 kA, 1 s

n Degree of protection in accordance w ith IEC 60529, EN 60529 up to IP 55

n Form of internal separation in accordance w ith IEC 60439-1, EN 60439-1, Para. 7.7

up to form 4

Available mounting techniques

n The circuit-breaker panel w ith SENTRON 3WL up to 3200 A or 3VL up to 1600 A 
n In-line design 3NJ6 (plug-in) for cable feeders up to 630 A in plug-in design

n Fixed-mounted panel (module doors or panel door/ front cover) for cable feeders up

to 1600 A 

n In-line design 3NJ4 (f ixed-mounted) for cable feeders up to 630 A

n Fixed-mounted panel for modular installation devices w ith panel door / front cover

n Panels w ith mounting plate, 19´´ guide frame

SIVACON 8PT SIVACON 8PT low -voltage sw itchboards provide a standard solution for building

installations and industrial design. The systems are built up from standardized modules

w hich - thanks to their multitude of combination options - meet all requirements. Their

high quality ensures a long service life and reliable plant operation.

This plant is only available in the "China" country setting.

Properties

n Standards and regulations:  
PSC pow er sw itchgear and controlgear assembly in accordance w ith IEC 60439-1,

EN 60439-1

Testing under conditions of arcing due to an internal fault in accordance w ith IEC

61641

n Clearance and creepage distances:

Rated impulse w ithstand voltage (Uimp) 8 kV

Overvoltage category III

Degree of pollution 3

n Rated insulation voltage Ui 1000 V, 50 / 60 Hz

n Rated operating voltage Ue up to 690 V

n Busbars 3-pole / 4-pole:

Horizontal main busbars 

Rated currents Inmax. 7400 A

Rated peak w ithstand current Ipkmax. 375 kA

Rated short-time w ithstand current ICWmax. 150 kA, 1 s or max. 120 kA, 3 s

n Degree of protection in accordance w ith IEC 60529, EN 60529 up to IP 54

n Form of internal separation in accordance w ith IEC 60439-1, EN 60439-1, Para. 7.7

up to form 4

Available mounting techniques

n Circuit-breaker panel w ith SENTRON 3WT up to 3200 A, 3 WL up to 6300 A or 3VL

up to 1600 A 
n Fixed-mounted panel (front covers or front doors) for cable feeders or motor

feeders up to 630 A

n Fixed-mounted panel for modular installation devices w ith panel door / front cover

n Panels w ith mounting plate
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8.4  Busbar systems
 SIVACON 8PS busbar trunking systems can meet all load demands reliably and safely w ith a complete product range for use from 40 A up to

6,300 A. The high short-circuit rating and low  fire load as w ell as type-tested connections to SIVACON sw itchboards and GEAFOL

transformers ensure maximum safety. The systems require little space, allow  for a clear netw ork design and can be installed quickly and

retrofitted or adapted w ithout any problems. The system also comprises communication-capable components. Enhanced safety is ensured

through the high short-circuit rating, the low  fire load and also through type testing.

BD01 system n To pow er electrical tools in w orkshops and for lighting systems 
n Use from 40 A up to 160 A 

n Rated operating voltage Ue max 400 V 

n Degree of protection up to IP 55

BD2 system n For pow er transmission and distribution in the medium current range in off ice buildings and for transfer lines in all

industrial sectors. 
n Use from 160 A up to 1250 A

n Rated operating voltage Ue max 690 V 

n Degree of protection up to IP 55

LD system n For the transmission and distribution of high currents in trade fair halls, the automotive industry, heavy industries

and on ships. 
n Use from 1,100 A up to 5,000 A 

n Rated operating voltage Ue max 1,000 V

n Degree of protection IP 34/IP 54

LI system n For pow er transmission from the transformer to the main distribution board in the building. 
n Use from 800 A up to 6,300 A 

n Rated operating voltage Ue max 690 V

n Degree of protection up to IP 55/IP 66

LX system n For the transmission and distribution of high currents in large buildings, radio stations, data centres, and for chip

and semiconductor production. 
n Use from 800 A up to 6,300 A 

n Rated operating voltage Ue max 690 V

n Degree of protection up to IP 55
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The overview  show s the busbar

trunking systems available at

Siemens.
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The overview  states the

designations of the various

components of a busbar trunking

system taking the BD2 system as

an example.
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8.5  Distribution boards
In plannning projects for countries in w hich distribution boards in accordance w ith DIN systems must be used, SIMARIS project relies on the

follow ing distribution board types from the ALPHA DIN distribution board range w hich are tested in accordance w ith DIN EN 60439-1/3, DIN

VDE 0603-1 for use as pow er sub-distribution boards.

ALPHA AS DIN modular distribution

boards 

8GK14

Degree of protection IP 55, safety class 1, for use up to 1250 A

ALPHA 630 DIN floor-mounted

distribution boards 

8GK13

Degree of protection IP 55, safety class 1, for use up to 630 A

ALPHA 400 DIN wall-mounted

distribution boards 

8GK11

For surface-mounting, degree of protection IP 43, safety class 1, for use up to 400 A
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ALPHA 160 DIN wall-mounted

distribution boards 

8GK10

For surface-mounting, degree of protection IP 43, safety class 2, for use up to 160 A

The components of the ALPHA distribution boards, i.e. the assembly kits and accessories, are provided in a platform structure.

In plannning projects for countries in w hich distribution boards in accordance w ith NF systems must be used, SIMARIS project relies on the

follow ing distribution board types from the ALPHA NF distribution board range w hich are tested in accordance w ith CEI EN 60439-1, IEC 60439-1,

CEI EN 61 439-2, IEC 61 439-2 (ALPHA AS and ALPHA 630), or in accordance w ith CEI 23-48, CEI 23-49, CEI 23-51 (ALPHA 125) for use as

pow er sub-distribution boards.

ALPHA AS NF floor-mounted

distribution board

8GK24

Degree of protection IP 55, safety class 1, for use up to 800 A

ALPHA 630 NF Wall- and floor-

mounted distribution board

8GK21, 8GK23

Degree of protection IP 55, safety class 1, for use up to 630 A
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ALPHA 125 NF Wall-mounted

distribution board

8GK20

Degree of protection IP 43, safety class 1, for use up to 125 A

To configure low -current distribution projects in SIMARIS project, ALPHA SIMBOX small distribution board types are used as sub-distribution

boards for low  currents.

ALPHA SIMBOX XL small distribution

boards 

(DIN) 8GB

Flush-mounting, degree of protection IP 30, safety class 2, for use up to 63 A

These distribution boards are tested in accordance w ith DIN VDE 0603, DIN 43871, IEC 60439-3 for

use in countries using DIN systems.

ALPHA SIMBOX T small distribution

boards

Flush-and surface-mounting, degree of protection IP 40, safety class 2, for use up to 60 A

These distribution boards are tested for use in countries using IEC systems,on the basis of IEC

60670-1, IEC 60670-24.

ALPHA SIMBOX MB small

distribution board

Flush mounting, degree of protection IP 30, safety class 2, for use up to 63 A.

These distribution boards are only available for use in China. Consequently, they are only listed for

selection if  the country setting "China" w as chosen.

To configure the functionality required for the project to be edited, devices, such as modular installation devices, moulded-case circuit-

breakers, sw itch disconnectors, in-line type fuse sw itch disconnectors, are available that match your choice of distribution board type and

size.
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8.6  Charging units of electric vehicles
Wall-mounted charging units as w ell as charging stations are available to design projects w ith charging units for electric vehicles.

They are tested in accordance w ith IEC/EN 61851 and IEC/EN 62196.

Wall box Wall-mounted charging unit for indoor and outdoor use, for private customers

Charging connection: cable

Charging current: 16 A to 32 A, degrees of protection IP 44/ IP 55

Charging station Stand-alone charging unit for indoor and outdoor use, for public customers

Charging connection: socket

Charging current: 40 A to 80 A, degree of protection IP 44
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